Contents
Connection to the MANTiS database ................................................................. 2
Memory settings ................................................................................................. 2
Main functionalities ............................................................................................ 2
‘Character Mapping’ View ................................................................................ 4
‘Genome content’ View .................................................................................... 5
‘Biological processes’ View ................................................................................ 5
Other icons in the ‘Biological Processes’ view .................................................. 6
Interactive Histograms ..................................................................................... 7
Category browser .............................................................................................. 7
‘Molecular functions’ view ................................................................................ 8
‘Gene expression’ view .................................................................................... 8
‘Tissue Specificity’ view .................................................................................. 8
Other icons in the ‘Gene expression’ view ...................................................... 8
Queries .............................................................................................................. 9
Tools .................................................................................................................. 11
How to cite MANTiS ......................................................................................... 12
Frequently Asked Question .............................................................................. 13
Connection to the MANTiS database

The MANTiS interface (available for Windows, Mac OS X, and Linux at www.mantisdb.org) connects to a MySQL database running on a server in the Laboratory of Artificial and Natural Evolution (LANE) in the Dpt of Zoology & Animal Biology at the University of Geneva (Switzerland). It requires a connection through the port 3306. This port might be blocked by a firewall, so ask your network administrator to unblock it for your machine, if necessary.

Memory settings

The user may define the maximum amount of memory used by MANTiS in the ‘Memory settings’ within ‘Tools’. The maximum amount depends on the computer capacities and the minimum is 256 Mb. If you run MANTiS on a 32-bit OS, you are limited to 2GB. If you run MANTiS on a 64-bit OS, you are not limited in the amount of allowable memory. The user must restart the applications for the settings to be applied. Please note that for heavy computations (like tree restrictions) a minimum of 512 Mb is required. Information of the system and the memory used by MANTiS may be obtained from ‘System information’ via the ‘Help’ menu.

Main functionalities

MANTiS main functionalities are associated to a phylogenetic tree.

- Use the ‘View’ menu to chose among (i) character mapping, (ii) genome content, (iii) biological processes, (iv) molecular functions, (v) gene expression, and (vi) tissue specificity.
- The ‘Tools’ menu includes utilities that facilitate the use of MANTiS: (i) Gene Fetching, (ii) General Statistics, (iii) Identifier converter, (iv) p-Value calculator, (v) Restrict tree to duplicated characters, and (vi) Memory settings.
- The ‘Help’ menu where a note with the latest updates is found and links the MANTiS website, this manual, MANTiS related publications, as well as information of the system (number of processors and memory usage).
- Some icons (red square below) are available for most views:
Tools for **zooming in/out** the phylogenetic tree and associated charts. You can also use the mouse wheel (up= **zoom in**; down= **zoom out**).

**Dataset selection:** MANTiS datasets are built using the *Ensembl* gene trees. This icon gives access to various *Ensembl* versions and allows choosing between two dataset "types":

- **‘With duplications’**: when parsing *Ensembl* gene trees, MANTiS generates one ‘character’ (or feature) for each duplication event.
  
  This dataset (generated with the latest ENSEMBL version) is chosen by default when starting MANTiS.

- **‘Families only’**: here, MANTiS ignores duplications and only considers *de-novo* gains. Hence, only one MANTiS character is created for each gene family tree.

and the topology of the phylogenetic tree where characters are mapped:

- **Phylogeny A**: where *C. elegans* is considered as the sister taxon of diptera

- **Phylogeny B**: where Coelomata and Bilateria are separated

Selection of the dataset and the topology is also requested when MANTiS is launched.

**Tree type:** allows switching between cladogram, phylogram and chronogram. The branch lengths of the latter represent the age of the branch. These numbers are displayed above the branches in the ‘Tree only’ view. Note that the branch lengths of each view provide different kind of information:

- **Tree only**: the branch lengths calculated by MANTiS.

- **Character mapping**: the branch lengths are proportional to the number of gains and/or losses at the specific branch

- **Genome content**: the branch lengths are proportional to the number of genes present on the branch

- **Biological processes/Molecular functions/Gene expression**: the branch lengths are proportional to the number of represented genes on the branch

- **Tissue specificity**: the branch lengths are proportional to the number of genes that have a tissue-specific expression

**Taxonomy:** when activating this icon, taxonomy information is displayed on internal branches following the NCBI nomenclature. These names can be used as input for queries.

**Export:** allows exporting the current view data to a tab-delimited text file (*e.g.* for opening in Macintosh ‘Numbers’ or Microsoft ‘Excel’).

**All changes:** is selected by default and allows to display all gains and all losses.
**Single changes**: allows displaying genes that are gained once but lost in no more than one branch.

**Queries**: opens a new dialog window to perform elaborate queries concerning gene identity, mapping, and function parameters (see below).

**Print**: prints the current view, using the current zooming level. MANTiS can print big trees in multiple pages.

### ‘Character Mapping’ View

- This view shows the number of gains and losses on each branch.

- Icons specific to this view are:
  
  ![Icon](image.png)

  Use and to mask/display the gains (+) or losses (-).

- Double clicking on a ‘gains/losses’ box ( ) opens the associated ‘gene browser’.

  The browser displays the list of genes, gained or lost on the selected branch. Clicking on a gene in the gene browser window prompts the display of additional information: gene description (with a link to the Ensembl gene page), identified orthologs, duplication events (branch at which the gene family emerged, duplication path between the origin of the selected specific gene and the origin of the gene family), biological processes, molecular functions and gene expression information the selected gene is associated with, developmental stages at which the gene is expressed and gene length data (the number of introns, and the length in base pairs with and without them. Note this gene information is provided at all MANTiS views. The list of genes (and all associated information) can be exported to a tab-delimited text file (e.g. for opening in Macintosh ‘Numbers’ or Microsoft ‘Excel’).
‘Genome content’ View

This view shows the number of genes inferred for each ancestral species (i.e., each internal node of the tree).

- Double-clicking on a ‘gene presence’ box opens the associated ‘gene browser’, displaying the list of genes present on that node. Clicking on a gene in the gene browser window prompts the display of additional information, as described in ‘Character Mapping’. Again, the list of genes (and all associated information) can be exported to a tab-delimited text file (e.g. for opening in Macintosh ‘Numbers’ or Microsoft ‘Excel’).

‘Biological processes’ View

This view shows, on each branch, a histogram with the ‘biological processes’ that are over- or under-represented in the set of gained genes (blue) or lost genes (yellow). Each column of the histogram shows a first level category (numbered as in the Panther database) that is either itself significantly over/under-represented (blue or yellow columns; binomial p-value < 0.05) or that contains over/under-represented subcategories (mauve columns). The Y-axis shows the representation index in logarithmic scale (see Helaers et al 2007 for details).

Important Note! When the ‘families only’ dataset is selected, the functions of all family members are considered to calculate the category significance and draw the histograms.

- When exporting from the main window, the distribution of genes to all Panther categories is given for each reference species (Homo sapiens, Mus musculus, Rattus norvegicus, and Drosophila melanogaster). Note that the hierarchy of the categories (1st, 2nd and 3rd levels) is also given.
Other icons in the ‘Biological Processes’ view

**Legend**: display all Panther category numbers and names.

**Global distribution**: display a pie chart representing the frequencies of all biological processes across all genes in the entire tree. The sum can be larger than the species gene set because some genes can be assigned to several categories. This pie chart gives access, by double clicking, to the category browser for all genes in the tree.

**Human**: representations of categories are computed for gains on branches leading to *Homo sapiens*, and for losses on all other branches. The representation significance level of each category is computed using *Homo sapiens* as the reference.

**Mouse**: representations of categories are computed for gains on branches leading to *Mus musculus*, and for losses on all other branches. The representation significance level of each category is computed using *Mus musculus* as the reference.

**Rat**: representations of categories are computed for gains on branches leading to *Rattus norvegicus*, and for losses on all other branches. The representation significance level of each category is computed using *Rattus norvegicus* as the reference.

**Drosophila**: representations of categories are computed for gains on branches leading to *Drosophila melanogaster*, and for losses on all other branches. The representation significance level of each category is computed using *Drosophila melanogaster* as the reference.

Show over-represented categories. The icon is grey when over-represented categories are hidden.

Show under-represented categories. The icon is grey when under-represented categories are hidden.

Add non-significantly represented categories in the histograms. The icon is grey when only **significantly** over/under represented categories are shown in the charts.

Activation of that icon shows (in purple) **non-significantly** over- (or under-) represented categories that **contain significantly** over- (or under-) represented sub-category(ies).

Allows the user to adjust the p-Value threshold for the ‘Biological processes’, ‘Molecular functions’ and ‘Gene expression’ views. The default value is 0.05.
Interactive Histograms

- Right-click (or ctrl-click) on a histogram opens a resizable window with a larger and interactive chart. The chart can be printed or exported (PNG format) using the corresponding icons in the window. Clicking on a column displays additional information: category name, total number of genes in the category, number of observed genes in the category, number of expected genes in the category, representation \( p\)-Value, number of gains on the corresponding branch, and fractional difference (the height of the column). The button opens the ‘category browser’.

- Double-clicking on a histogram opens the ‘category browser’.

Category browser

- The left panel displays a classification hierarchy with the represented categories. Each category icon indicates if the category is over-represented ( ) or under-represented ( ). Blue columns correspond to gains, yellow ones correspond to losses. If the icon is red-circled ( ), it means that the category is significantly over/under represented (\( p\)-Value < 0.05 or otherwise set by the user).

- The right panel shows information on the selected category and the list of corresponding genes for the current branch. Clicking on a gene prompts the display of additional information on this gene (if the gene is also found in other categories, it is indicated there).

- The two buttons under the classification hierarchy are for expanding all subcategories and exporting all gene-information (including all categories associated to each gene and the number of 1\(^{st}\), 2\(^{nd}\) and 3\(^{rd}\) level categories it belongs to) to a tab-delimited text file (e.g. for opening in Macintosh ‘Numbers’ or Microsoft ‘Excel’).
‘Molecular functions’ view

The functionalities in this view are identical to those described in the ‘Biological processes’ view (see above).

‘Gene expression’ view

The functionalities in this view are identical to those described in the ‘Biological processes’ view (see above). The only difference is that it is possible to display data from three databases: (i) EST for eGenetics up to version 49 of Ensembl and Unigene from version 50 and on, (ii) GNF for microarray data from BioGPS and (iii) HMDEG (see below for more information).

‘Tissue Specificity’ view

This view shows pie charts on each branch of the tree. Each pie chart represents, for the gains (or losses) associated to the corresponding branch, gene expression assignment to specific ontology terms of anatomical systems. Pie charts show frequencies of assignments to anatomical systems only among the genes exhibiting tissue specificity.

- When exporting from the main window, the distribution of genes to all anatomical system categories is given for each available database (EST, GNF, HMDEG). For each gene recognized as tissue-specific by EST and GNF, the tissue with the smallest HMDEG $p$-value is also given.

- A right-click (or ctrl-click) on a pie chart opens a resizable window with a larger and interactive pie-chart, whereas a double-click opens a gene expression category browser.

- In the gene expression category browser, the left panel displays the gene expression classification and the right panel shows information on the selected category, the list of corresponding genes, and compares the anatomical systems assigned by different expression databases (EST, GNF, HMDEG).

Other icons in the ‘Gene expression’ view

Pie charts are drawn using gene expression data from the eGenetics database (up to version 49 of Ensembl) and Unigene (for the latest versions of Ensembl).

Pie charts are drawn using gene expression data from the GNF database (BioGPS).

Shows the total number of genes used for drawing each pie chart.
Queries

The query window allows building complex question to the MANTiS database.

Each MANTiS query is composed of one or several ‘statement(s)’ linked by logical operators. In each statement, four criteria can be considered (or ignored) in combination or isolation: a subset of user-defined genes, the type of events mapped (gains and/or losses or presences, with ‘all’ or ‘single’ changes), a subset of branches, and specific functions (biological processes, molecular functions, or gene expression). If the query contains more than 2 statements, you must also set the priority of each operator. Non-selected criteria in any given statement will be ignored (e.g., a list of genes can be considered regardless of their function, known or unknown, of the corresponding genes).

Criteria:

- **Genes**: defines the gene subset that will be considered in the query. You can provide the gene subset in different ways:
  - Directly type a list of ‘gene IDs’ either separated with semi-colon (;) or with one gene per line. Any typed gene will automatically be converted into the corresponding MANTiS character.
  - Import a file (using the ‘+’ button) containing a gene ID on each line or gene IDs separated by a semi-colon (;)
  - Selecting “gene family” instead of “gene list” prompts MANTiS to fetch, for each provided ID, all characters corresponding to other members of the gene family.
  - Selecting “all other genes” will prompt MATiS to fetch all characters of the database minus all the ones corresponding to the IDs listed in the other statements.
  - Ensembl (protein or transcripts) ID’s, but also Unigene or Entrez ID’s are recognized by MANTiS.

- **Tracing**: Allows to consider only genes present, only gains or only losses, and all or single changes.

- **Branches**: Allows selecting the set of considered branches. You can provide the branch list in different ways:
  - Directly type the branch IDs (one branch ID per line or IDs separate with ‘;’)
  - Directly typing the branch names (e.g., ‘Homo sapiens’) or an approximation of it (e.g., ‘hsapiens’ or ‘homo sap’), and MANTiS will attempt identifying it.
  - Click on the ‘+’ button to open the ‘branch selector’ and click on branches you wish to select.
  - Selecting “all other branches”, it will take all branches minus all the ones listed in the other statements.

- **Functions**: Allows restricting the fetched genes to those pertaining to a selected function type (within ‘biological processes’ or within ‘molecular functions’ or within ‘gene expression’). You can provide the list of functions in different ways:
- Directly type the function names (one function per line or names separated with ‘;’)
- Click on the ‘+’ button to open the ‘function category selector’, and click on the functions you wish to select.
- Selecting ‘function of level X’, is equivalent to selecting all function categories of level X (levels 1, 2, & 3 available). All genes associated to a level 2 category are necessarily found in the corresponding level 1 category; and genes of level 3 are always found in corresponding levels 1 and 2.

- **‘Complementary’ boxes (for gene / branch / function):** checking one or several of these boxes negates the relevant part of the statement, hence, generates its complement.

When two or more statements are defined, each statement is executed separately and the result sets are merged using the logical operator selected by the user (‘AND’, ‘AND NOT’, ‘OR’, ‘XOR’ – see below). The order in which the result sets are merged is given by the priority list (green box at the bottom of the query window).

![Diagram of logical operators](image)

After the statements have been defined, one or several actions must be applied.

- **List genes / branches / functions:** simply lists the target field following the criteria of your statements.
- **Restrict tree:** lists the genes and creates a new dataset for MANTiS, containing only the genes of the query result. All gains, losses, biological processes/molecular functions histograms and gene expression pie charts are recomputed using this new, restricted, dataset. All MANTiS views change accordingly, and the user can switch back and forth between the original (full) and the new (restricted) datasets by clicking the purple query icon that appears on the toolbar.
- **Count mapping / functions:** adds a new condition on the mapping / functions. Same occurrences of the same mapping / function are grouped and counted. The result window displays only the genes that have the selected count (defined by the operator + number).

The user can also fine-tune the information that will be displayed in the result window using the ‘display’ and ‘Group & Count’ fields (for ‘gene’, ‘mapping’, ‘branch’, and ‘function’).

**Result Window.** In the result window, the user can:

- Create a new query, using the result genes and/or branches and/or functions (check the corresponding box).
- Export the results to a tab-delimited text file (e.g. for Microsoft Excel).
- Display genes that were not found in the MANTiS database.
Tools

• ‘Gene Fetching’

This tool allows for searching gene IDs using their Ensembl description. Search criteria placed between “signs can be linked by three operators: AND, OR and NOT (e.g., “ubiquitin” AND “ligase”). The results may be exported using the button or used for a query by clicking on the button.

• ‘General Statistics’

Choosing this tool opens a new window where numerous graphs are available summarizing MANTiS data. For example, one can

✓ plot the number of gains for each branch along the lineage leading to human (or any other species or internal node), as shown in the first figure below,

✓ plot, across a given lineage, the number of anatomical systems in which genes (gained within each specific branch) are expressed, as shown in the second figure below.

The General Statistics tool has been extensively used for the following publications:

✓ Milinkovitch M.C., Helaers R., Depiereux E., Tzika A.C., & T. Gabaldon
2X genomes - depth does matter
Genome Biology, 11 (2): R16 (2010)

✓ Milinkovitch M.C., Helaers R., & A.C. Tzika
Historical Constraints on Vertebrate Genome Evolution
• ‘Identifier converter’
This tool allows converting IDs between the following formats:
✓ Ensembl gene ID,
✓ Ensembl transcript ID
✓ Ensembl protein ID,
✓ Entrez ID
✓ Unigene ID.
The entry IDs can be typed, cut/pasted, or imported from a file. An optional checkbox allows converting the list of genes to their corresponding MANTiS characters (referred to as “main genes”, see Helaers et al. 2007 for details).

• ‘p-Value calculator’
This tool implements the same algorithm as that used for computing p-Values in the ‘Biological processes’, ‘Molecular functions’ and ‘Gene expression’ views.

• ‘Restrict tree to duplicated characters’
This tool performs a restriction in which only the characters originating from a duplication are maintained (de novo characters are excluded). This function is available only in the ‘with duplications’ dataset and requires a great amount of memory, so it may be necessary to modify the memory setting (see below) and restart MANTiS.

• ‘Memory settings’
This tool allows to easily modify the maximum amount of memory attributed to MANTiS.

How to cite MANTiS

MANTiS: a phylogenetic framework for multi-species genome comparisons
Athanasia C. Tzika®, Raphaël Helaers®, Yves Van de Peer & Michel C. Milinkovitch
Bioinformatics 24 (2):151-157

# These authors contributed equally
Frequently Asked Question

- **Why the name ‘MANTiS’?**
  MANTiS (μάντης) is the Greek word for a ‘seer’, meaning ‘a person able to see into the future’, and it was chosen to reflect the software’s capability of answering complex queries.

- **How can I find the total number of genes of each species?**
  In the ‘Genome content’ view (‘all changes’ option), the ‘Presence’ box on each terminal branch indicates the number of genes of the corresponding species.

- **How can I get the complete list of genes contained in each category (‘Biological processes’, ‘Molecular functions’, and ‘Gene expression’)?**
  You can use the export button in the main window to generate a text file containing the categories’ arborescence and a list of all genes contained in each category and subcategory. You can also display the global distribution (using the corresponding icon), then open the category browser and export the information from there. The file will however be different from that generated by exporting from the main window (see above): the text file will include a list of all genes and, for each one, information on its mapping, orthologs, function, etc.

- **How can I get additional information on the columns of the histogram (for ‘Biological processes’ and ‘Molecular functions’) or the sections of the pie-charts (for ‘Gene Expression’)?**
  By right-clicking on a chart, a window containing only this chart will open. If you click on the columns/sections additional information appears (category name, size, number of expected/observed genes, and exact value).
• **When I select to display ‘significantly over-represented’ categories along with ‘non-significant categories having a significant sub-category’, why are there categories appearing as under-represented?**

If a first-level category is under-represented (so, it wouldn’t be included itself in the ‘significantly over-represented’ view) AND contains a second or third level category that is significantly over-represented, then information related to the first level category will be shown, with the column coloured in purple. By opening the category browser, it is possible to check which sub-level category is concerned.

• **In the category browser of ‘Gene expression’, why has HMDEG different annotations than EST or GNF?**

Only information on the anatomical system within which a gene is expressed is provided for EST (Unigene) and GNF (BioGPS) databases, whereas the tissue with the lowest $p$-value is given for HMDEG. MANTiS provides mapping of all database information into a single category system, and the same colour code is used to facilitate comparison among the three databases.
• **Within queries, what does the ‘group and count’ option exactly do?**

Imagine that a query returns the following result set, with ‘display’ ‘gene’ and ‘display’ ‘function’ selected:

<table>
<thead>
<tr>
<th>Main gene</th>
<th>Gene</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSG000000010404</td>
<td>ENSMUSG00000035847</td>
<td>Sulfur metabolism</td>
</tr>
<tr>
<td>ENSG000000010803</td>
<td>ENSMUSG000000000085</td>
<td>Developmental processes</td>
</tr>
<tr>
<td>ENSG000000010803</td>
<td>ENSMUSG000000000085</td>
<td>Nucleoside, nucleotide and nucleic acid metabolism</td>
</tr>
<tr>
<td>ENSG00000011304</td>
<td>ENSMUSG00000068274</td>
<td>No information</td>
</tr>
<tr>
<td>ENSG00000011376</td>
<td>ENSMUSG00000035202</td>
<td>Protein metabolism and modification</td>
</tr>
<tr>
<td>ENSG00000012817</td>
<td>ENSMUSG00000056673</td>
<td>Developmental processes</td>
</tr>
<tr>
<td>ENSG00000012817</td>
<td>ENSMUSG00000056673</td>
<td>Nucleoside, nucleotide and nucleic acid metabolism</td>
</tr>
<tr>
<td>ENSG00000050820</td>
<td>ENSMUSG0000031955</td>
<td>Cell structure and motility</td>
</tr>
<tr>
<td>ENSG00000050820</td>
<td>ENSMUSG0000031955</td>
<td>Cell adhesion</td>
</tr>
<tr>
<td>ENSG00000050820</td>
<td>ENSMUSG0000031955</td>
<td>Cell proliferation and differentiation</td>
</tr>
<tr>
<td>ENSG00000050820</td>
<td>ENSMUSG0000031955</td>
<td>Oncogenesis</td>
</tr>
<tr>
<td>ENSG00000052802</td>
<td>ENSMUSG0000031604</td>
<td>Lipid, fatty acid and steroid metabolism</td>
</tr>
</tbody>
</table>

If you select ‘group’ by ‘function’, all lines having the same Main gene (=MANTiS character) and same Gene will be merged, and the count will be set on the ‘function count’ column:

<table>
<thead>
<tr>
<th>Main gene</th>
<th>Gene</th>
<th>Function Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENSG000000010404</td>
<td>ENSMUSG00000035847</td>
<td>1</td>
</tr>
<tr>
<td>ENSG000000010803</td>
<td>ENSMUSG000000000085</td>
<td>2</td>
</tr>
<tr>
<td>ENSG00000011304</td>
<td>ENSMUSG00000068274</td>
<td>2</td>
</tr>
<tr>
<td>ENSG00000012817</td>
<td>ENSMUSG00000056673</td>
<td>2</td>
</tr>
<tr>
<td>ENSG00000050820</td>
<td>ENSMUSG0000031955</td>
<td>4</td>
</tr>
<tr>
<td>ENSG00000052802</td>
<td>ENSMUSG0000031604</td>
<td>1</td>
</tr>
</tbody>
</table>

• **Can you give me an example using the complementary option in a query?**

If you provide ENSG000000010404 as Gene list and select ‘complementary’ ‘gene’, then the query will return results for all genes except ENSG000000010404.

• **Can you give me an example using the option ‘any other genes’ in a query?**

This option is similar to the ‘complementary’ option, but it refers to the selections in other statements. For example, if you give a ‘gene list’ including ENSG00000010404 in statement 1, a list including a ‘gene family tree’ with ENSG000000010803 in statement 2, and you select ‘any other gene’ in statement 3, then, when executing statement 3, the query will return all genes except ENSG000000010404 and except all genes in the family tree of ENSG000000010803.
• **Can you give me an example using the ‘count mapping’ action?**
  
  You can, for example, find all genes that were lost in 4 different branches or more. To answer that question, just make one statement and select ‘Losses’ in ‘tracing’. Choose the ‘count tracing’ action and set it to ‘>= 4’. This query will generate the list of genes lost in 4 branches or more, and the exact number of branches.

• **How can I fetch all genes gained at one branch and not lost anywhere else?**
  
  You need to make two successive queries:
  
  First, make a query to get all gains of the branch of your choice (e.g., branch 66).

  Then, on the query result window, click on the ‘gene’ field in the ‘data to export in a new query’ section. Now, export the genes in a new query by clicking the ‘query’ icon (red arrow).
In the new query window, the gene list field is already filled with the genes gained on the branch of interest. You can now select ‘Losses’ in ‘tracing’, and set the ‘count tracing’ action to ‘= 0’.

Done 😊

Another option would have been to set the view to ‘Single changes’ (instead of ‘All changes’): the gains shown on a branch are then the ones that are lost nowhere else.
• **How can I fetch all genes having a ‘Biological process’ of level 1 and not one of level 2 or 3?**

Create statement 1 with ‘function of level 1’, statement 2 with ‘function of level 2’ and statement 3 with ‘function of level 3’. Link them with the ‘AND NOT’ operator and select the ‘List genes’ action. You will obtain all genes having a level 1 function only.

![Image of MANTiS Manual interface](image_url)

• **How is the number of genes present at a branch calculated at the ‘Genome content view’?**

For ‘Genome content’, it is important to realize that we start at the root and we "move" towards the tips of the tree. The procedure is as follows: the genes gained at a specific branch are added to the ones of the previous branch and the losses are subtracted.

Let’s take the genome content of *Danio rerio* as an example (version 45):
- ‘families only’ dataset and single changes: 7440 genes present in *Danio rerio*
  Explanation: 7440 gene families that were gained at any branch between the root and *Danio* and were not lost anywhere or lost only once at the whole tree
- ‘families only’ dataset and all changes: 13537 genes present in *Danio rerio*
  Explanation: 13537 gene families that were gained at any branch between the root and *Danio* and were not lost along the specific path (but they may have been lost several times elsewhere at the tree)
- ‘with duplications’ dataset and single changes: 13605 genes present in *Danio rerio*
  Explanation: 13605 genes that were gained at any branch between the root and *Danio* and were not lost anywhere or lost only once at the whole tree
- ‘with duplications’ dataset and all changes: 28593 genes present in *Danio rerio*
  Explanation: 28593 genes that were gained at any branch between the root and *Danio* and were not lost along this path (but they may have been lost several times elsewhere at the tree)
- **How does the p-value calculator work?**
Imagine that one wants to know if a biological process is significantly represented or not in a given dataset (e.g. the results of a query). The following numbers need to be given:
- Species size: the number of genes the reference species has, as given at the ‘Genome content’ view
- Category size: the number of genes the category of interest has at the reference species, as given at the Global distribution of the ‘Biological processes’ view
- Set size: the number of genes in the given dataset
- # observed: the number of genes in the given dataset that have the biological process of interest